
Subscribing to Sites
The usual way to subscribe to a site is to double-click on a masthead file, which has an extension of 
.fxm. You may find masthead files while browsing the Internet or someone may send you a masthead 
file as an attachment to an email message. If you find one on the Internet, you will usually only have 
to select it to download and execute it. If someone sends it as an attachment, simply save the file 
somewhere on your disk and double-click it.

Another way to subscribe to a site is to find a Fixlet site that lists a collection of subscriptions. A Fixlet 
message can activate a masthead automatically, so your subscription is only a click away. 

In general, if you come across a file with a .fxm extension, follow these simple steps to activate the 
subscription:

1 Double-click on the desired .fxm file (or choose Subscribe from the Site menu and browse to 
the masthead file).

BigFix will display the masthead, which lists certain information about the Fixlet site.

2 Click the “Add Fixlet site Now” button.

An icon for the Fixlet site shows up in the Sitebar. You can treat this Fixlet site like any other Fixlet 
site, setting it to automatically gather on any schedule you wish.



Deleting (Unsubscribing from) a Fixlet Site
If a Fixlet site doesn’t provide what you want, you can delete or unsubscribe from it. To stop a 
subscription to a Fixlet site, follow these steps:

1 Select the Fixlet site to delete from the Sitebar.

2 Drag the chosen Fixlet site icon outside of the Sitebar.

3 When the cursor turns into an X, release the mouse button.

4 A dialog box will pop up to confirm that you want to delete the Fixlet site.

5 Click the Unschedule button.



Gathering Fixlet Messages
Fixlet site subscriptions have a schedule to guide their updates. The program automatically connects 
to the net for the latest Fixlet messages. However, you can manually force an update if you don’t 
want to wait for the scheduled one. To manually gather Fixlet messages from a Fixlet site, follow 
these steps:

1 Click on the Fixlet site you want to update from the Sitebar.

You can also select multiple Fixlet sites to update simultaneously. Press the control key while clicking 
to add another Fixlet site to the selection. Or click the All Fixlet sites button to select them all.

2 Click on the Gather button in the tool bar.

You will see a progress bar in the status line at the bottom of the screen. When the Fixlet site (or 
group of Fixlet sites) is downloaded, the progress bar disappears and any newly relevant Fixlet 
messages will be displayed.

Note: You may also use the gather command from the Fixlet site menu to gather from the currently 
selected Fixlet sites.



Scheduling
When you subscribe to a Fixlet site, it automatically comes with a schedule suggested by the 
publisher of the Fixlet site. However, you can change this schedule to better suit your personal needs. 
To change the scheduled gathering times for your Fixlet sites, follow these steps:

1 Select the Fixlet site to reschedule by right clicking on the Fixlet site icon. A pop-up menu 
appears.

2 Select Schedule from the pop-up. The schedule dialog box appears with the current settings.

3 Make any changes you want to the schedule.

These are your options:

• Publisher Recommended. This is the default schedule, set by the publisher to reflect the actual 
Fixlet site activity. This is the most common setting.

• Custom Schedule. If you check this box, you also need to select the desired period from the 
pull-down menu next to it. It allows periods from fifteen minutes to two months.

• Gather Manually. Select this box if you want to take personal control over the gathering. The 
program will no longer gather from this Fixlet site on a scheduled basis, and will instead wait for 
user input.

• Disable Gathering. Click in this check box to stop all contact with this Fixlet site, even if an 
attempt is made to manually gather it. This is how you can make the Fixlet site an archive.

4 Click OK.

You can click on other Fixlet sites (or multiple Fixlet sites) while this dialog box is open, so you can 
adjust all the schedules at one time.



Blocking Download Periods
You can restrict downloads to certain times. That way you can take advantage of better phone rates 
or traffic patterns. To block downloads, follow these steps:

1 From the File menu, select Preferences. A dialog box appears. 

2 Click to put a check mark in the box labeled Limit Download Times.

3 In the two fields below, type the starting and ending times for restricted downloading.

4 Click OK.

Now, when a Fixlet site is ready to be synchronized, it will first check to make sure that 
communications are not blocked.



Stopping During a Download
You can terminate a connection, even in the middle of a download. This can be helpful if, for instance, 
it is taking too long for the download or you change your mind. To stop the connection, just:

• Press the stop button.



Viewing Fixlet Messages
After you’ve subscribed to a few Fixlet sites, you should start to see relevant Fixlet messages being 
displayed. When a Fixlet message becomes relevant, it is shown in the Fixlet list. To view the body of 
the Fixlet message, just:

1 Click on the line corresponding to the Fixlet message you want to view.

The body of the Fixlet message will open in its own window. 

2 Use the Font button in the toolbar to adjust the size of the text in the HTML display.

Fixlet messages are the basic atoms of the BigFix technology. They can become relevant when your 
computer configuration or your Fixlet site Profile triggers them. That means they can be anything from 
tech support to a stock market report. 



Reading a Fixlet Header
Each Fixlet message has a header that summarizes the action and displays the actual relevance 
language that is evaluated by BigFix. To view this header, follow these steps:

1 Click on the View menu to display it.

2 From the menu, select Fixlet Header.

If you look at the View menu again, you should see a check mark next to the Fixlet Header item. From 
now on, when you open a new Fixlet message, you will see an extra area at the top of the Fixlet 
window. It will display the subject line and the relevance clause for that Fixlet message.

To turn off this display, repeat the two steps above to toggle the Fixlet Header off.



Navigating
To leaf through the relevant Fixlet windows, use the right arrow to go forward through the list and the 
left arrow to go back through the Fixlet messages you’ve already seen.

You may have visited a web site by clicking a link in a Fixlet message. If so, the arrows will also 
include these web pages in the list of windows that you can navigate.



Using Action Buttons
Once you’ve read a Fixlet message and agreed with its assessment, you will most likely want to act 
on it. A Fixlet message usually comes with some sort of written description of how to fix the problem, 
but some Fixlet messages also offer an automatic fix. To take advantage of these “Action Buttons,” 
follow these steps:

1 Select a Fixlet message with an Action Button. The Fixlet message opens up in its own window. 

2 Scroll down through the Fixlet message until you see a link or a button that will automate the 
procedure.

3 Click on the link or button.

4 Follow the instructions for the Action Button.

There are many different kinds of Action Buttons, but all of them present you with a confirming dialog 
box. Here are some typical remedial actions that you can expect:

• Downloading a file. 

Here, you are prompted to click a link to get a file from an Internet Site. Usually, this is a driver or an 
updated version of a program. You will get a second chance to cancel the action from the download 
dialog box.

• Finding a file. 

Often, the problem results when a file on your computer has been inadvertently moved. BigFix has a 
utility that can help you locate the file and return it to where it belongs. It will display a dialog box that 
will describe the suspected file and prompt you to move or copy it.

• Moving, renaming or copying files. 

Sometimes a problem can be fixed by simply moving a file. To deal with this category of remedies, 
BigFix has a utility that can issue a basic set of Windows commands. A dialog box appears, 
describing the commands. After making sure they do what you expect, click on the OK button.

• Resetting a registry entry. 

If your registry gets corrupted, you can reinstate the parts you need. A dialog box will appear, 
describing the values it wants to restore, and ask for confirmation.



Finding and Sorting Fixlet Messages
By using the column headers of the Fixlet list, you can sort the Fixlet messages. This can help you to 
find specific Fixlet messages or a range of them. For instance, to find the Fixlet message that most 
recently became relevant, but hasn’t been read yet, follow these steps:

1 Click on the “Relevance Date” header.

Every time you click on the header, it changes the direction of the sort. Make sure the triangle is 
pointing down, for a descending sort. That way the most recent Fixlet message is sorted to the top.

2 Click on the “Read” header.

Click on the header until the arrow is pointing up, for an ascending sort. This will display all the 
unread Fixlet messages first. If there is more than one Fixlet message that hasn’t been read yet, they 
will be sorted by the previous sort, in this case the Relevance Date field.



Finding a Lost or Renamed File
Occasionally a file accidentally gets moved or thrown in the trash or renamed. Most applications 
expect to find files in the correct place, and when they aren't the program may crash. To avoid this, 
Fixlet messages can be written to "nail-down" the location of essential files. Whenever a file is 
missing, the Fixlet message is triggered. Typically, this Fixlet message will include an action button 
that offers to retrieve the file.

BigFix has a utility that will search your hard drive for the missing file. Even if the name has changed, 
as long as the file isn't corrupted, this utility will find it. To recover the file, follow these steps:

1 Select the relevant "nail-down" Fixlet message from the Fixlet list.

2 Click on the button or hypertext link to find the corrupted file.

A dialog box is displayed containing the location and name of the recovered file.

3 Click on the Move button to put it back in place.

When you do this, BigFix will notice that the file is back in its proper spot. The Fixlet message, no 
longer relevant, disappears from the list.

How does this work? First, the application and all of its essential files are “nailed-down.” This means 
that all the pertinent data about these files are examined and the results are saved in a Fixlet file.

As long as everything stays in its proper place, the application will behave normally. But when a file is 
inadvertently renamed or dumped into the trash, the nail-down Fixlet message is activated and you’re 
notified of the problem. 



Printing a Fixlet Message
You can print the text of a Fixlet message. This is handy if, for instance, the Fixlet message requires 
you to turn off your computer while you execute the instructions. To print a Fixlet message, follow 
these steps:

1 Click on the Fixlet message you want to print from the Fixlet List.

If the Fixlet message is already displayed in the top window, you may skip this step.

2 When the desired Fixlet window opens up, click on the printer icon on the toolbar.

The text of the Fixlet message will be sent to your printer.



Loading a Fixlet Pool
BigFix can be run in two modes: Single Pool (which is the default) and Multi-Pool. If you choose Multi-
Pool mode, you can have more than one pool, or group, of Fixlet sites. This is useful to organize your 
sites into small, manageable groups. It can also help reduce the complexity of a multi-user setup -- 
each user can have his or her own named Fixlet pool. 

To switch to Multi-Pool mode and load a pool, follow these steps:

1 From the File menu, select Preferences. A dialog box appears. 

2 Click to place a check mark in the box marked “Multiple Fixlet Pools.”

If the box is already checked, skip the above step.

3 Click OK. The dialog box is dismissed. 

4 From the File menu, select Open Fixlet Pool. A File browser window is displayed. 

5 Navigate to the desired directory and select a Fixlet pool to load.

Note: New items are listed in the File menu when Multi-Pool mode is selected. These menu items are 
to create new pools, open existing pools or save the current pool.



Sending Mail to a Fixlet Site
You may want to correspond with the author of a Fixlet site. If you’ve had a problem with his or her 
Fixlet messages, or if you just want to thank them for outstanding service, you can send them email. 

To reply by email to the author of a Fixlet site, follow these steps:

1 Select a Fixlet site from the Sitebar by clicking with the right mouse button. A pop-up menu will 
appear.

2 Select Reply To from the menu. Your default email program launches, and the appropriate fields are 
automatically filled in.

3 Enter a subject for your message.

4 Write your message in the text window.

5 Send the email.

6 Quit the email application. 



Editing a Fixlet Site Profile
Fixlet authors use inspectors to examine your computer locally and determine the relevance of their 
Fixlet messages. But there are many things beyond the ability of your computer to determine on its 
own. Among these items are peripherals that connect over a “dumb wire” and provide no feedback -- 
like many printers, modems and monitors. For this equipment, there is no substitute for asking the 
user. To fill out or edit a Fixlet site Profile, follow these steps:

1 Make sure you are subscribed to a Fixlet site that has a Profile.

2 Right click on the desired Fixlet site in the Sitebar. A pop-up menu appears. If Edit Profile is 
grayed out, it means there is no profile for this Fixlet site. 

3 Select Edit Profile from the menu. An HTML form will appear. 

4 Fill in the fields of this HTML profile.

Usually, this will be questions about serial numbers or model names. Each Fixlet site will have its own 
collection of fields. Fixlet messages from that Fixlet site will query the field values, using the result to 
determine the relevance of each Fixlet message.

5 Click on the Enter button at the bottom of the profile.

That will put a copy of the information on your computer only. Unlike a traditional web form, this 
information never leaves your machine and is for local use by the BigFix application only.

Now, with the information contained in the profile, the Fixlet site can offer Fixlet messages that are 
relevant to your particular monitor or printer. Once the question is answered, other Fixlet sites can 
also take advantage of the information -- so you don’t have to enter the information more than once.



Deleting Fixlet Messages
Sometimes a Fixlet message has no way to determine that the problem it describes has been fixed. 
When this happens, the Fixlet message will continue to be displayed even though it may no longer be 
relevant. To delete this Fixlet message, follow these steps:

1 Select the Fixlet message to delete from the Fixlet list.

2 Drag the selection to the trashcan in the toolbar.

Note: When you synchronize with a Fixlet site, BigFix downloads all the Fixlet messages from the 
Fixlet site -- including any Fixlet messages you may have deleted. This means that you can never 
really delete a Fixlet message from your hard drive. However, the Fixlet message will stay tagged as 
deleted and won’t be displayed again unless you pull it out of the trash (see Undeleting Fixlet 
messages, below).



Undeleting Fixlet Messages
To undelete a Fixlet message, follow these steps:

1 Click on the trashcan icon on the toolbar. The trash dialog is displayed, containing a list of all the 
deleted Fixlet messages.

2 Select any Fixlet messages you want to pull out of the trash. Use the Ctrl and Shift keys while 
clicking to select multiple Fixlet messages at one time.

3 Press the button labeled “Restore Selected Fixlet messages.”

The Fixlet message(s) will disappear from the trash window and be inserted back into the Fixlet list.



Emptying the Trash
When an item is placed in the trash, it is no longer available for evaluation of relevance, but it is still 
possible to bring it back, as the previous section (Undeleting Fixlet messages) explains. Thus the 
trash is a holding area, and if you change your mind, you can pull Fixlet messages back out.

If you are sure you no longer need the Fixlet messages in the trash, you can empty the trash. When 
you do, it will be difficult to retrieve those Fixlet messages, so proceed with caution. To empty the 
trash, follow these steps:

1 Click on the Trash icon on the tool bar.

2 Click on the Empty Trash button.



Retrieving Fixlet Messages after Emptying the Trash
If you change your mind after emptying the trash, don't despair. You have another chance to retrieve 
Fixlet messages. To do so, you must unsubscribe from the affected Fixlet site and then re-subscribe. 
The BigFix application will load the Fixlet messages as if they were a brand-new site and all your 
Fixlet messages will be restored. Follow these steps to retrieve your Fixlet messages after you empty 
the trash:

1 Right click on the affected site on the Sitebar. 

2 From the pop-up menu, select Unsubscribe

3 Click the Unsubscribe button on the confirmation dialog.

4 From the site menu, select subscribe.

5 From the Open     dialog box   , select the Masthead for the original Fixlet site.

6 Select the Add Site Now button.

The affected site is now restored, with all the trashed Fixlet messages available for evaluation again.



Viewing the Log file
As the program connects to the net to gather subscriptions, it keeps a log of each event to help you 
trouble-shoot subscription problems. To see the log file, follow these steps:

1 Right-click on the Fixlet site you want to investigate.

2 Select Log from the pop-up menu.

A dialog box appears, displaying the log of events that have occurred for this Fixlet site or group of 
Fixlet sites.



Viewing the Statistics
To see the statistics, follow these steps:

1 Right-click on the Fixlet site you want to investigate.

2 Select Stats from the pop-up menu.

A dialog box appears, displaying statistics about the currently selected Fixlet site or Fixlet sites. The 
values are listed as raw numbers and as a percentage of the total. The statistics track the following 
variables:

• Processing Time
• Disk space
• Number of Fixlet messages
• Number of Fixlet sites



Protecting a Fixlet Site from Unsubscribing
You can make sure that a given Fixlet site will be permanent. That means that no one can 
accidentally unsubscribe from the site. To protect a Fixlet site, follow these steps:

1 Right click on the desired Fixlet site from the site icon bar.

2 Select Schedule from the pop-up menu.

3 Check the box labeled Don't Allow Unsubscribing.



Customizing the Interface
BigFix has a flexible interface that you can customize to better suit your personal taste. The tool bars 
and other interface elements that can be changed have a “gripper” at the top or left end (see figure). 
To move an interface element, follow these steps:

1 Click on the gripper section of the window or toolbar you want to move.

2 Drag the mouse around the screen.

As you drag an interface element, you will notice that a box outline of its window is dragged around 
with the mouse. If the box is near an edge of the main screen, it will change shape and orientation to 
indicate where it will appear when you release the mouse.

3 Place the element where you want it.

You can “dock” the box to any edge of the main screen or you can drag it out of the window 
altogether. 

4 Release the mouse.

If you drag the box away from an edge, it won’t dock to the main window but will instead become a 
stand-alone window.

Note: As mentioned, you can drag an interface element out into its own window. When you do, it acts 
like any other window: you can grab it by the title bar and drag it around. If you want to dock it back 
up to the main window, simply drag it by the title bar back to where you want it and release the 
mouse. If you click on the close button in the title bar, the window will disappear. To bring it back, 
select the appropriate option from the View menu.



Background Mode
To set BigFix for background operation, simply:

1 Click on the File Menu

2 Select Exit to Tray.

The program will close its windows, and place an icon in the tray (on the taskbar). It will now operate 
in the background at a low priority, so as not to interfere with the active application.

The taskbar, which also includes the Start button, is usually at the bottom of your desktop screen. If 
you let the mouse linger over the tray icons, a text box will appear to describe each one. Like BigFix, 
these programs are all working in the background.

Note: If you don't see Exit to Tray in the File menu, you must go to the Preferences dialog under the 
File menu and set the program to Tray Mode.



Active Mode
Although it usually operates in the background, BigFix can be brought forward any time you wish. To 
bring it to the foreground, just:

• Double-click the BigFix icon on the Taskbar.

The program will open on your desktop.



Arranging Fixlet Sites on the Fixlet Sitebar
You can change the order of the Fixlet sites on the Fixlet sitebar to place the most-used Fixlet sites in 
a convenient position. To re-arrange the icons in the Fixlet sitebar, follow these steps:

1 Select the icon that you want to move.

2 Drag it over to where you want it to appear. When the cursor is properly positioned, a dark line will 
show up where the site icon will be inserted.

3 Release the mouse button when the dark line is where you want the icon to be placed.

The Fixlet site icon will be moved to the new position.



Definitions



BigFix
The program that evaluates relevant fixlet messages and displays the results. It also refers to the 
network set up around fixlet providers.



directory
A FixSite with Directory assistance for other FixSites. It can be reached at 
http://www.BigFix.com/directory.



download
Receive data from the Internet. When you download a file, you are copying a file, usually from the 
hard disk of an Internet-connected computer called a server.



file directory
A folder or directory in a file system. This can be a directory on your hard drive or a shared directory 
on a network.



Fixlet header
Every Fixlet has a header that specifies certain information, including the organization, a fixlet 
expression, a subject line, date, etc. This header is in standard MIME format.



Fixlet message
An Internet message with a relevance clause that allows it to be targeted to just the users and 
computer systems that need it. Fixlet messages are most often about computer hardware and 
software, but can include almost any subject matter.



Fixlet list
A window in the user BigFix interface that contains a list of the currently relevant fixlets for the 
selected group of FixSites.



Fixlet pool
A specially-named group of FixSites. You can create and save fixlet pools to help you organize your 
subscriptions. 

To use fixlet pools, select Preferences from the File menu and check the box labeled Multiple Fixlet 
Pools. This mode adds several commands to the File menu to help you manage your fixlet pools.



Fixlet site
An Internet site set up to offer fixlets on a subscription basis. The site consists of a set of files on a 
server with a URL address. 



gather
To download fixlets from a FixSite. See synchronize.



HTML
HyperText Markup Language. The language that underlies web pages.



Internet
The loosely-defined set of computers around the world that are connected to one another. Spelled 
with a capital "I" it stands for the worldwide net. With a lowercase "i" it stands for local networks, such 
as a corporate net.



privacy
The concept of keeping personal information local to your computer only. With perfect privacy, nothing 
leaves the computer without your permission.



registry
A set of hundreds of variables that describe most of the essentials of your computer system. These 
variables contain information about your modem, printer, applications and more. 



relevant
A fixlet that is applicable to your or your particular computer system is called relevant. Relevance is 
determined by examining your computer system or individual fixlet site profiles. 



security
The concept of keeping unwanted programs off of your computer. BigFix offers security by limiting its 
Relevance Language to inspection only. 

For action buttons, the BigFix application always shows you a step-by-step listing of the impending 
action. You must give permission before the execution of these commands can take place.



sitebar
A group of icons, one per FixSite, placed in a bar for fast access.



synchronize
To gather fixlets from a FixSite; to make a mirror image of a FixSite on your local computer.

Usually, you will use the fixlet publisher's recommended schedule to synchronize, but you can set up 
a custom schedule if you desire.



taskbar
Usually located at the bottom of your desktop screen, the taskbar contains the Start button and the 
tray.



toolbar
A group of commonly used commands brought out into a set of buttons on the application screen.



tray
A part of the taskbar where icons are placed to indicate programs that are working in the background. 



upload
Send data over a network or the Internet. When you upload a file, you are sending it to another 
computer.





File menu
The File menu offers the following commands in multi-pool mode:

New Fixlet Pool Creates a new Fixlet Pool.
Open Fixlet Pool Opens an existing Fixlet Pool.
Save Fixlet Pool Saves an opened Fixlet Pool with the current name.
Save As Saves an opened Fixlet Pool with a different name.
Close Closes an opened Fixlet Pool.
Recent A list of most recently used files.

The following menu commands are always available from the file menu:

Print Prints the active window.
Preferences. Sets user preferences for the program.

Exit Exits BigFix.



New Fixlet Pool (File Menu)
Lets you start a new Fixlet pool that you can populate with subscriptions. You can create pools for 
different interests or for different users to simplify your site management.

If you haven't saved the current pool, you'll be prompted to do so.

Shortcut
Keys: CTRL+N



Open Fixlet Pool... (File Menu)
Use this command to open an existing Fixlet pool.    You will be presented with an Open dialog box . 
Select the Fixlet pool (.fxg) of your choice. Each pool is a collection of subscriptions that appear in 
the sitebar.

You can create new Fixlet pools with the New command.

Shortcut
Keys: CTRL+O



Save Fixlet Pool (File Menu)
Use this command to save the open Fixlet pool to its current name and directory.    When you save a 
pool for the first time, BigFix displays the Save As dialog box so you can name your document.    If 
you want to change the name and directory of an existing document before you save it, choose the 
Save As command.

Shortcuts
Keys: CTRL+S



Save As... (File Menu)

Use this command to save and name the current Fixlet pool.    BigFix displays the Save As dialog box 
so you can name your document. 

To save a document with its existing name and directory, use the Save command.



Close    (File Menu)
Use this command to close the currently open Fixlet pool. Before closing an untitled document, BigFix 
displays the Save As dialog box and suggests that you name and save the document.

Shortcut
Keys: CTRL+W



Import Fixlet File... (File Menu)
This command brings up an Open dialog box . Select the desired .fxf file from the list.

If someone sends you a Fixlet file through email, this is how you would view it. This is not the same 
as subscribing to a Fixlet site, which has regularly scheduled updates. 



Print (File Menu)
Opens up the Print dialog and prepares to print the currently active window in the BigFix application.

Use this command to print the currently active window. This command presents a Print dialog box, where you 
may specify the range of pages to be printed, the number of copies, the destination printer, and other printer 
options. Click on the Properties button to adjust the Print Setup.

Shortcuts

Toolbar:
Keys: CTRL+P



Print Setup (File Menu)
Use this command to select a printer and a printer connection.    This command presents a Print 
Setup dialog   box  , where you specify the printer and its connection.



Preferences (File Menu)
The selection opens the Preferences dialog box where certain global properties of the program can 
be set.



Most Recently Used Files (File Menu)
This is variable sized list of the files most recently used by BigFix. These can include Mastheads as 
well as Fixlet pools.



Exit (File Menu)
Use this command to end your BigFix session.    You can also use the Close command in the upper 
right corner of the BigFix application window. If you have any unsaved Fixlet pools, BigFix prompts 
you to save them.

To exit to the tray, make sure the Tray box is checked in the Preferences dialog (File Menu).

Shortcuts
Mouse: Click the application's Close button.

Keys: ALT+F4
CTRL+Q



Exit to Tray (File Menu)
This command minimizes the program and places an icon in the System Tray (located on the 
taskbar). You can start the program again by double clicking on the tray icon.

To exit normally without going to the tray, make sure the Tray box is unchecked in the Preferences 
dialog (File Menu).

You can also use the Close command in the upper right corner of the BigFix application window to 
exit to the tray. 

Shortcuts
Mouse: Click the application's Close button.

Keys: ALT+F4
CTRL+T



 View menu 
The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Sitebar Shows or hides the sitebar window.
Text Labels Shows or hides labels on the toolbar and sitebar

Fixlet List Shows or hides the list of relevant Fixlet messages
Sort Fixlet List by > Displays a pull right menu that lets you select sort fields

Fixlet Header Shows or hides the Fixlet header when opening a Fixlet message.
Font Size Cycles through fonts of different sizes.



View Toolbar (View Menu)
This menu command is a toggle. Each time you select it, you change the state from selected (with a 
checkmark) to deselected (no checkmark).

Use this command to display and hide the Toolbar, which includes buttons for some of the most 
common commands in BigFix, such as the navigation arrows, gather and print. 

Turning off the toolbar is provided as an option to give you the more screen space for Fixlet 
messages. However, you pay a price: you need to go to the menus to select these common 
commands, instead of simply clicking a button.



View Sitebar (View Menu)
This menu command is a toggle. Each time you select it, you change the state from selected (with a 
checkmark) to deselected (no checkmark).

This command lets you view all of the Fixlet sites you're currently subscribed to. Each Fixlet site is 
represented by an icon in the Sitebar. 



View Text Labels (View Menu)
This menu command is a toggle. Each time you select it, you change the state from selected (with a 
checkmark) to deselected (no checkmark).

Select this option to see a text description underneath each toolbar button and each sitebar icon. This 
is the default value. Once you've become familiar with the toolbar and the sitebar icons, you can turn 
the text descriptions off and save space on the screen.



Fixlet List (View Menu)
This menu command is a toggle. Each time you select it, you change the state from selected (with a 
checkmark) to deselected (no checkmark).

Select this option to toggle the list of Fixlet messages on and off. The default is to show the Fixlet list. 
The list is helpful, since it gives you an over-all picture of relevant Fixlet messages. However, you can 
navigate through the list with just the Back and Next arrow keys, so the list is not completely 
essential. If you want more space to view the Fixlet body, try operating without the list.



Sort Fixlet List by > (View Menu)
This menu selection is hierarchical and contains a list of fields to sort by:

Date of Relevance
Fixlet site
Read Status
Subject
Resolution Date
Size of Fixlet Message
Relevance

In addition to these fields, you have two options for sorting:

Ascending
Descending



Sort by Date of Relevance (View Menu)
This command sorts the Fixlet messages by the date that this Fixlet message last became relevant.



Sort by Fixlet Site (View Menu)
This command sorts the Fixlet messages by the name of the Fixlet site.



Sort by Read Status    (View Menu)
This command sorts the Fixlet messages by the status of the read flag. 



Sort by Subject (View Menu)
This command sorts the Fixlet messages by the subject line. 



Sort by Resolution Date (View Menu)
This command sorts the Fixlet messages by the date of the last resolution. 



Sort by Size of Fixlet Message (View Menu)
This command sorts the Fixlet messages by the size (in bytes) of the Fixlet message. 



Sort by Relevance    (View Menu)
This command sorts the Fixlet messages by the value of the relevance expression, which can be 
either true or false. Since the program defaults to showing only relevant expressions, this sort key 
usually has no effect.



Sort Ascending (View Menu)
This command works in concert with the other sort selections in this menu to sort the Fixlet messages 
in ascending order.



Sort Descending (View Menu)
This command works in concert with the other sort selections in this menu to sort the Fixlet messages 
in descending order.



View Fixlet Header (View Menu)
This menu command is a toggle. Each time you select it, you change the state from selected (with a 
checkmark) to deselected (no checkmark).

Select this option to toggle the display of the Fixlet header. The default is to not show it, but the 
header contains information (such as the relevance expression) that can be useful. 



Font Size (View Menu)
This selection clicks through five states, from small fonts to big fonts. After the largest font is selected, 
clicking font a sixth time starts over again with the smallest font.

Shortcut

Toolbar:



Site menu 
The Site menu offers the following commands:

Subscribe Subscribe to a Fixlet site.
Gather Download the Fixlet files from the given Fixlet site
Reply to... Send an email to a site administrator.
Unsubscribe Unsubscribe from a site.
Properties > View the properties of this Fixlet site



Subscribe (Site Menu)
This command lets you subscribe to a Fixlet site. It brings up a Open dialog box  and filters the 
directories for Masthead (.fxm) files. Click on the desired Masthead to subscribe to that site.



Gather (Site Menu)
This command causes the program to synchronize with the selected Fixlet site(s). Although the Fixlet 
sites are designed to automatically update themselves on a regular schedule this command can be 
handy if you think some new Fixlet messages have shown up at the Fixlet site(s) in question.

This command is available from the Site Menu, by right-clicking on the desired Fixlet site Icon and in 
the schedule property page.

Shortcut

Toolbar:



Reply to (Site Menu)
This menu item brings up your current email program with the Fixlet author’s email address filled in. 
Once there, just fill in the body of the letter and press the send button.

This command is available from the Site Menu and by right-clicking on the desired Fixlet site Icon.



Unsubscribe (Site Menu)
This command terminates your subscription to a Fixlet site. If a Fixlet site isn’t giving you what you 
need, you can simply quit it and recover the space it was using. 

This command is available from the Site Menu and by right-clicking on the desired Fixlet site Icon.



Properties (Site Menu)
This menu command brings up a pull-right menu containing the various property sheets for the 
currently selected Fixlet sites. These property sheets include:

Masthead
License
Log
Schedule
Statistics
Profile



Go menu 
The Go menu offers the following commands:

Back Go to the previous Fixlet message.
Next Go to the next Fixlet message.

Refresh Refreshes the HTML screen
Stop Stops gathering sites

BigFix Web site Takes you to the BigFix Web Site
Fixlet Site Directory Takes you to the BigFix directory of Fixlet Sites



Back (Go Menu)
The back command takes you to the previously viewed window, whether it’s a web page or a Fixlet 
body. If you have stacked up several web page windows, it will take you back through each one until it 
hits the Fixlet window that started the stack. Then it will take you through the previous stack, if there is 
one.

Shortcut

Toolbar:
Keys: SHIFT+CTRL+B



Next (Go Menu)
The next command takes you to the next window. It is the counterpart to the back arrow, and it will go 
forward through the Fixlet windows and web pages that you've already stacked up. When you reach 
the last page in the last stack, it will start going through the rest of the unread Fixlet messages.

Shortcut

Toolbar:
Keys: SHIFT+CTRL+N



Refresh (Go Menu)
This command forces a new request for a given web page. Use this command if there is something 
wrong with how the web page downloaded, or if the page is designed to be updated frequently.



Stop (Go Menu)
This command will stop an Internet connection. This can be handy if you change your mind, or the 
download is taking too long.

Shortcut

Toolbar:



BigFix Web Site (Go Menu)
Click here to visit the BigFix Web Site. 

Shortcut

Toolbar:



Fixlet Site Directory (Go Menu)
Click here to visit the BigFix Web Site. 



Window menu 
The Window menu offers the following commands, which enable you to arrange multiple views of multiple 
documents in the application window:

Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Close All Closes all open windows

Show Trash Shows the contents of the Trash



Cascade (Window Menu)
Use this command to overlap multiple opened windows. All the currently active windows will be 
opened sequentially, starting at the upper left and "cascading" down to the lower right. 



Tile    (Window Menu)
Use this command to arrange multiple opened windows in a non-overlapped fashion.



Window Arrange Icons Command (Window Menu)
Use this command to arrange the icons for the minimized windows at the bottom of the main window. 
If there is an open document window at the bottom of the main window, then some or all of the icons 
may be obscured.



Close all (Window Menu)
Close all of the currently opened windows.



Help menu
The Help menu offers the following commands, which provide assistance with the BigFix application: 

Help Topics Offers you an index to topics on which you can get help.
About BigFix Displays the version number of this application.



HelpTopics (Help Menu)
Brings up the Help dialog box, which contains a table of contents, an index and a find command.



Context Sensitive Help
When you select context sensitive help, the cursor changes to include a question mark. Move the 
cursor to the item that interests you and click to find out more.



End User License Agreement    (EULA)
This is the full text of the license agreement that you make with BigFix, Inc. when you receive the 
BigFix software. It specifies all your rights and limitations.



About BigFix (Help Menu)
Displays the About Box, which contains the copyright notice and version number of the program.



Preferences Dialog



The Preferences Dialog
This dialog is used to set certain preferences in the BigFix application. Changes you make here will 
persist even after you quit the program. 

From this dialog you can change the way the program looks, whether you want to maintain multiple 
sets (called pools) of Fixlet sites, and other scheduling options.



Multiple Fixlet Pools
Check this box to create multiple collections (or pools) of Fixlet site subscriptions. When this box is 
checked, an extra set of commands is added under the File Menu. These commands let you create, 
open, save and close Fixlet pools.



Tray Mode
Check this box to run the program in tray mode, which allows the program to operate in the 
background. In tray mode, when you exit the program, it will minimize to an icon in the System Tray.



Show Action Confirmation
Check this box to display a confirmation dialog before running Fixlet Actions.



Bitmap Background
Check this box to select a custom image as the background texture. This is the texture that is behind 
the toolbars and the frame of the application windows.



Select Bitmap
Click this button to bring up an Open Dialog. Browse through your folders to find an appropriate 
bitmapped image file (.bmp) to serve as a background image.



Default Bitmap
Click this button to return to the default bitmap for the BigFix application.



Block Automatic Gathering
Check this box to disable the automatic gathering of your Fixlet site subscriptions. No gathering will 
be done until this box is unchecked or unless you manually gather from the Fixlet site.



Limit Download Times
Check this box to limit the hours for gathering from a Fixlet site subscription. When this box is 
checked, the BigFix application will only gather during the indicated period. You can use this to limit 
gathering to nighttime or only during work hours, for instance.



If the Limit Download Times box is checked, this represents the earliest time that gathering will 
occur. Before this time, gathering from a Fixlet site is blocked.



If the Limit Download Times box is checked, this represents the latest time that gathering will occur. 
After this time, gathering from a Fixlet site is blocked.



When Schedule Directs
If you would like to control how BigFix connects to the Internet for automatic gathering, use this menu 
selection. The three choices are: Postpone until connected, Ask to connect and Connect 
automatically. 



Use AOL Connection
This preference is only available when America Online is installed. Check this box to use AOL when 
BigFix connects to the internet. 



Apply the changes you've made to the BigFix Preferences before closing this dialog.



 Site Properties



HIDD_SHEET_SITE 

174 // all property sheets



Masthead



Go to Masthead
This command takes you to the Masthead property page. Right-click on a Fixlet site and choose 
Masthead from the menu.



Masthead
This dialog contains the Masthead for the currently selected Fixlet site. The Masthead is a separate 
file (with extension .fxm) that points to the URL of the actual Fixlet site. It contains information about 
the organization as well as the publisher of the site.

Shortcuts
Mouse: Right-click on the Fixlet site icon



Click this button to send an email message to the author of this Fixlet site. This command will bring up 
your email program (if it is properly registered) with a blank body ready for you to fill in. The to: line 
will have the address of the person listed to the right of this button.



The name of the organization that is providing the Fixlet messages from this Fixlet site.



This is the URL (Uniform Resource Locator) for the selected Fixlet site. 



The email address of the author of this Fixlet site. When you click the Reply to button to the left of 
this field, this address is placed on the to: line of the email.



A description of the Fixlet site. 



License



Go to License
This command takes you to the License property page. Right-click on a Fixlet site and choose 
License from the menu.



License
This is the license properties page for the selected Fixlet site. This property displays the license 
statement for the currently selected Fixlet site(s).

Shortcuts
Mouse: Right-click on the Fixlet site icon



Fixlet Site Warranty
This is a warranty by the publishers of this site. This statement outlines a policy that all licensed Fixlet 
sites must follow to protect your privacy and security.



Warning!
This warning has been presented because the BigFix program can't validate the license number 
contained in the masthead for this Fixlet site. As a consequence, you have no assurance that this site 
will follow the guidelines created by BigFix, Inc. to protect your security and privacy.



BigFix Licensing
This statement says that BigFix, Inc. licenses Fixlet sites. As a part of the license, the Fixlet publisher 
agrees to a code of ethics that is designed to protect your security and privacy.



Log



Go To Log
This command takes you to the Log property page. Right-click on a Fixlet site and choose Log from 
the menu.



Log
The log properties page keeps a running tab on the subscription and gathering activities of the BigFix 
program. The log includes the date for each activity over a user-defined period of days. The activities 
logged include gathering, deleting and the use of action buttons.

Shortcuts
Mouse: Right-click on the Fixlet site icon



Select a period of time for logging events. If you want to be able to examine the log for the last month, 
you should set the number of days to 31. The default value is five days.



Use this control to increase the number of days in the log (up arrow) or decrease the number of days 
(down arrow).



Click this button to show the log for the day previous to the currently displayed day.



Click this button to show the log for the day after the currently displayed day.



This is the log for the given day of the selected Fixlet site(s). If more than one site is selected, the logs 
for each site are merged into one, sorted by the time of each event.



Schedule



Go To Schedule
This command takes you to the Schedule property page. Right-click on a Fixlet site and choose 
Schedule from the popup menu.



Schedule
This property page contains information about the schedule of the selected Fixlet site(s). It lets you 
customize the schedule to suit your needs. For further control over the schedule, look at the limit 
options in the Preferences Dialog.

If more than one site is selected, the check boxes take on an extra meaning. A black check or a clear 
check means all the selected sites share the same gathering option. A gray check mark means that 
for the current collection, some Fixlet sites don't share the option. If you set or clear a check box while 
a collection of sites is selected, the program will apply the option to each Fixlet site in the collection. 

Shortcuts
Mouse: Right-click on the Fixlet site icon



Check this box to use the subscription schedule recommended by the publisher of the Fixlet site. This 
is the default for a new subscription.



This is the subscription schedule recommended by the publisher of this Fixlet site.



Check this box to specify a schedule different from the one designated by the author of the Fixlet site. 
Use the pull-down menu to the right to set the desired schedule.



This pop-up menu lets you select a custom schedule for gathering from the selected Fixlet site(s).



This check box essentially disables automatic gathering on the selected Fixlet site(s). As long as this 
box is checked, you will have to manually click on the gather button to the left (or the Site menu or 
from right-clicking on the Sitebar) in order to gather the latest information from the site(s).



This check box disables gathering on the selected Fixlet site(s). You will no longer be able to 
synchronize to these sites, turning them into an "archive" of the subscription. To gather from this site, 
you must clear this check box.



Check this box to permanently subscribe to the selected Fixlet site(s). If this box is checked, you 
won't be able to unsubscribe from this site through the program menus. This feature can be used to 
protect a subscription from accidental deletion. To unsubscribe from a protected Fixlet site, you must 
first clear this checkbox.



Statistics



Go to Statistics
This command takes you to the Statistics property page. Right-click on a Fixlet site and choose 
Statistics from the menu.



Statistics
This is the Statistics property page. It lists certain important statistics about the selected Fixlet site. If 
more than one Fixlet site is selected, this dialog lists the combined stats for the entire collection.

Shortcuts
Mouse: Right-click on the Fixlet site icon



This is the date that your subscription started with the selected Fixlet site(s). 



Multiple Fixlet sites have been selected so there is a range of starting dates for the collection. This 
field, along with the field above, defines the range of starting dates for the collection. 



This is the date of the last successful gathering of the selected Fixlet site(s).



Multiple Fixlet sites have been selected so there is a range of gathering dates for the collection. This 
field, along with the field above, defines the range of gathering dates for the collection. 



This is the number of Fixlet sites currently selected in the Sitebar. You can select more or fewer sites 
at any time while this dialog is displayed.



This number represents the total number of sites that you are currently subscribed to.



This is the percentage of Fixlet sites -- out of your total subscriptions -- that are currently selected 
from the Sitebar for statistical analysis.



This is the number of Fixlet messages selected for statistical analysis. It is the sum of the Fixlet 
messages in all the Fixlet sites selected from the Sitebar.



This is the total number of Fixlet messages from all of your subscriptions.



This is the percentage of Fixlet messages -- out of the total number of Fixlet messages -- that are 
currently selected.



This is the total accumulated time (in milliseconds) that it takes to evaluate the selected set of Fixlet 
messages.



This is the total time (in milliseconds) that it takes to evaluate every Fixlet message from every Fixlet 
site.



This is the percentage of time -- out of the total time -- that it takes to evaluate the currently selected 
Fixlet messages.



This is the size (in kilobytes) of the currently selected Fixlet site(s).



This is the total size (in kilobytes) of all your current Fixlet site subscriptions.



This is the percentage of the storage -- out of the total storage space -- taken up by the currently 
selected Fixlet site(s).



This button refreshes the evaluation of all the Fixlet messages, providing a new set of numbers for the 
Milliseconds field, above. Due to caching and other vagaries of Fixlet message evaluation, this time 
may fluctuate slightly.



 Profile



Go to Fixlet Site Profile Property Page
This command takes you to the Profile property page. Right-click on a Fixlet site and choose Profile 
from the menu.



Fixlet Site Profile Property Page
This dialog contains information about the Fixlet site profile attached to this site. The profile extends 
the items that can be checked by the Relevance Language. The profile variables stay on your 
computer and are never sent out without your express permission.

Shortcuts
Mouse: Right-click on the Fixlet site icon



Edit Fixlet Site Profile Variables
This command brings up the Fixlet site profile form for you to edit. This command is available from the 
profile property page (Site Menu) and by right-clicking on the desired site in the Sitebar.



Fixlet Site Profile Variable List
This is a list of the current variables and their values for this Fixlet site. The column headers for the 
variables include: 

name: the name of the variable.

value: a string or a number value for the variable.

site: the Fixlet site that this variable belongs to.



HIDD_PROFILE_DIALOG 

180 // dialog that holds edit profile variables form



Trash Dialog



Open Trash
Displays the trash can which contains a listing of the Fixlet messages you have placed there. You 
may want to put a Fixlet message in the trash if it doesn't automatically disappear, or if you decide it 
isn't relevant.

You can empty the trash, however you won't be able to easily retrieve those Fixlet messages. 

Shortcut

Toolbar:



Trash List
This is a listing of the Fixlet messages in the trash. You can empty the trash or retrieve Fixlet 
messages from the trash. If you empty the trash, you won't be able to easily retrieve these Fixlet 
messages. 

While clicking on the mouse, you can 

• Hold down the shift key to select everything between the cursor and the last selected Fixlet 
message.

• Hold down the control key to add the current Fixlet message to the selection.



Use the scrollbar to move through the list of Fixlet messages in the trash.

HIDC_TRASHLIST_SCROLLBAR 

1080 // scroll bar for trash list



Restore Fixlet Messages from the trash
This command will take the selected Fixlet messages out of the trash. They will be returned to the 
Fixlet site they came from for continuing relevance evaluation.



Empty the Trash
This command will empty these Fixlet messages from the trash. Use this command with caution -- it is 
difficult to retrieve a Fixlet message when it has been emptied from the trash.



Mainframe



HIDR_MAINFRAME_MULTI_POOL 

203 // main menu multi pool / non tray mode



HIDR_MAINFRAME 

128 // the menus (single pool/not in tray)



Add Site Dialog



FixSite Masthead

This dialog displays information about the Fixlet site to which you are subscribing.    It tells you the 
name that will be given to the site along with the organization that created the site.    You can also see 
a description of the kinds of fixlets you should expect from the site, the email address of the Fixlet site 
administrator, and the icon that will represent the site on the sitebar.    Click 'Add Site Now…' to begin 
gathering fixlets from the site or 'Cancel' if you do not want to subscribe at this time.



Update Masthead



FixSite Masthead Update

When you try to open a fixlet site definition that shares the same location as a site that is already in 
your sitebar, you will see this dialog.    From here you can review any differences between the existing 
and new site definition file.    If you want the site to take on the new values, click the 'Update Site Now' 
button.    Your only other alternative is to cancel the update.



Unsubscribe 



This is the name of site you are removing.



Fixlet List



Fixlet List
This is a list of the currently relevant Fixlet messages for the selected Fixlet site(s). Click on an item in 
the list to display the Fixlet body. You can sort this list by clicking on the column headers. The headers 
include:

Subject A short description of the Fixlet message.

Read A flag to indicate whether or not you have already read (opened) the Fixlet message.

Site The name of the Fixlet site that created this Fixlet message.

Relevance The date that the Fixlet message became relevant.

Note: If you can't see the Fixlet list, go to the View menu and make sure that Fixlet List is checked.



 #This is the Fixlet list. Click on a Fixlet message to display its contents.



The Fixlet list. This window contains a list of all the currently-relevant Fixlet messages. Click on any 
line to open the Fixlet message up in the main window.



Scroll through the list of Fixlet messages with this scroll-bar.



 #Choose this menu item to change the status of the selected Fixlet message(s) to the read state. 
This happens automatically when you click on the Fixlet line.



Choose this menu item to change the status of the selected Fixlet message(s)back to the unread 
state. This can be a useful way to keep urgent or unfinished items at the top of your list.



Choose this menu item to delete the selected Fixlet message(s). The deleted message(s) will be 
placed in the trash can. 



This is the name of the site as defined by the site author.



 #Fixlet Header
This window contains information from the Fixlet header, such as the subject line, the relevance 
expression and keywords.



Unsubscribe dialog
This dialog box is to confirm that you want to unsubscribe from the listed site. Click the Unsubscribe 
button to terminate the subscription and remove the Fixlet messages from this site.



Unsubscribe confirmation 
Click here to unsubscribe from the given Fixlet site.    Note that all the Fixlet messages from this site 
will be removed from your disk. 



 Findfile dialog



Find File

You have misplaced a file.    The list contains files that MAY be the lost file.    They are ranked by their 
resemblance to the lost file.      You may choose any of the files in the list as a replacement for the 
missing file.    Choose Copy if want both files to exist.



BigFix Confirm
A file has been misplaced.    BigFix will search for the misplaced file on the desktop, in the recycle-bin, 
in the folder that originally contained the file, its descendant folders and its the parent folder.    As it 
scans these folders it looks for files whose length matches that of the original file.    For each file 
whose length matches, BigFix calculates a checksum and compares this to the original checksum 
which has been captured in the fixlet.    If it finds a file with matching length and checksum in any of 
these folders, it displays this confirmation box.    Click 'Copy' to have BigFix copy the file to its original 
location.    Click 'Move' or 'Rename' to have the file moved back into place. 



Action Button



Shell Command dialog box
This dialog presents a preview of the action button shell commands. Read this carefully and make 
sure you understand what's about to happen before you click on the OK button.



This is a preview of the shell commands that will be executed when you click on the OK button.



Registry Command dialog box
This dialog presents a preview of the action button registry commands. Read this carefully and make 
sure you understand what's about to happen before you click on the OK button.



This is a preview of the registry commands that will be executed when you click on the OK button.



Script Command dialog box
This dialog presents a preview of the action button visual basic program or java script. Read this 
carefully and make sure you understand what's about to happen before you click on the OK button.



This is a preview of the visual basic program or java script that will be executed when you click on the 
OK button.



Site Bar



Sitebar
This is a strip of icons that represent the Fixlet sites you've subscribed to. Click on the globe to select 
all the Fixlet sites. Click on individual Fixlet sites to see Fixlet messages from one site at a time, or 
use the Ctrl and Shift keys while clicking to select a range of sites.



HIDB_BITMAP_ALLSITES 

200 // the all sites bitmap



HIDB_DEFAULT_SITE_BITMAP_MEDIUM 

203 // site bitmap if none provided or imported file



HIDD_SITE_LIST_DIALOG_BAR 

1541 // the site list docking dialog bar control



HIDR_MENU_SITEBAR_POPUP 

192 // the popup you see when right click on site



Status Bar 



Status Bar
This status bar is a general information display. It provides two different kinds of information:

1. As the    cursor moves across the program window, a brief explanation of each interface element is 
displayed.

2. If you are connected to the Internet, the status bar will reflect the URL that is currently being 
accessed.



Gathering



Gather Fixlet Messages
This command causes the currently selected Fixlet site(s) to be downloaded, or synchronized.



This is the name of a Fixlet site.



Permission To Connect
Depending upon your Connection Preference BigFix may ask for permission to connect to Fixlet 
sites for the purpose of gathering the latest information.    You are shown the name of the site that is 
ready to gather.    Click Connect to allow BigFix to proceed with gathering.    Click Try later to have 
BigFix postpone all gathering operations for one hour.    Click Skip this gathering if you want BigFix 
to delay gathering until the next scheduled time to gather.    You may also change your Connection 
Preference in this dialog.    The Connection Preference can also be adjusted in the Preferences 
dialog available from the File menu.



BigFix Unable To Gather
When BigFix gathers Fixlets from sites, it may fail to contact the site for a number of reasons. At this 
time you are shown the name of the site that is having the problem along with a short description of 
the failure.    Click Try again to have BigFix repeat the operation. Click Cancel to have BigFix stop 
gathering.    Click Skip This Site if you are gathering from several sites and you wish to skip this one 
and continue gathering from the remaining sites. 



Progress Bar



This is the Progress dialog box. It displays the current state of the site gathering. Depending on the 
speed of your modem, this may be a fast or lengthy process. This dialog helps you to monitor the 
progress and to terminate it, if so desired.



Click this button to stop synchronizing or gathering. This can be useful if you have a slow connection, 
or you just want to defer the gathering until later.



This is the name of the site currently being synchronized or gathered.



Tray



HIDR_MAINFRAME_MULTI_POOL_TRAY 

204 // main menu multi pool / tray mode



HIDR_MAINFRAME_SINGLE_POOL_TRAY 

205 // main menu single pool / tray mode



HIDR_MENU_TASKBAR_POPUP 

202 // show window/exit pop up menu from tray



HIDR_TRAY_NORMAL_ICON 

197 // normal tray icon



HIDR_TRAY_BLINKON_ICON 

198 // blink 1 tray icon



HIDR_TRAY_BLINKOFF_ICON 

199 // blink 2 tray icon



Show Window from Tray
Use this command to bring the BigFix application up and to the front.



Exit from Tray
This command causes the BigFix application to terminate and leave the tray.



Toolbar



HIDD_TOOL_DIALOG_BAR 

1542 // the docking toolbar control



HIDC_TOOL_LIST 

1095 // control holds all tools in toolbar control



 #HIDB_TOOL_BACK_OFF 

214 // off versions of above



HIDB_TECH_SUPPORT_ICON 

223 // the bigfix tech support site bar icon



 #HIDB_TOOL_HOME_OFF 

225 // off of above



Toolbar

The toolbar is a strip of icons that provides quick mouse access to some popular commands used in 
BigFix. The    toolbar can be moved by dragging its gripper (the edge with the diagonal lines). You can 
move the toolbar to another spot in the program window, or you can pull it out of the interface 
altogether and "float" it around the desktop. 

To hide or display the Toolbar, choose Toolbar from the View menu.

Click To

Go to the previous Fixlet message or Web Page.

Go to the next Fixlet message or Web Page.

Stop downloads and Fixlet site gathering.

Contact the BigFix Web Site.

Print the active window.

Cycle through five font sizes for easier reading.

View the contents of the trash can.

Gather the latest information from a Fixlet site.

Provide context help for the user interface..



Bit Maps



HIDR_ADVICETYPE 

129 // a bitmap that says ASI ???



HIDB_DEFAULT_SITE_BITMAP 

187 // site bitmap if none provided or imported file



HIDB_BITMAP_ARCHER 

188 // our backdrop



Stuff



Site Profile
This is extra information requested by the selected Fixlet site. Fill in these fields and press the Save 
button at the bottom. This information is stored locally. BigFix never sends this information over the 
net, so feel free to be thorough.



HIDC_CHECK_SHOW_FAILURES 

1133 // in the check dialog, check box to show or hide ‘failures’



HIDB_SPLASH 

226 // our splash screen bitmap



HIDD_MSGBO_xDIALOG 

196 // dialog for all OK, OKCancel, YesNoCancel boxes



HIDC_CURSOR_BARSIZE 

162 // adjust size of windows cursor



HIDR_KNOWLEDGEBASETYPE 

130 // 'kno' icon ???



HID_ADVICE_SHOW_ALL_TOGGLE 

32910 // shift control t



HIDD_DOCK_FORM 

101 // our form view document



Authoring



HIDC_EVALUATION_THRESHHOLD 

1121 // author mode, control holds number of milliseconds of relevance execution to flag as 
error



HIDM_AUTHOR_SHOW_CHECK_DIALOG 

107 // bring up the syntax check window



HID_ADVICE_SHOW_ALL 

108 // the Author/Show all menu entry



HID_ADVICE_RELEVANT 

109 // the Author/Relevant Only Menu entry



HIDC_FIND_TEXT 

1082 // in author find text dialog, control holds editable text to search for



HIDC_CHECK_FROM_TOP 

1084 // in author find text dialog, check box to start searching from top



HIDC_EDIT_ERROR_LOG 

1085 // in author mode, list of errors at bottom which can be clicked on



HIDC_EDIT_ADVICE 

1086 // rich edit control holds digest being edited in authoring mode



HIDC_CHECK 

1081 // 'check selected sites' button in author/syntax check... dialog



HIDD_EDIT_FIND_DIALOG 

194 // in author mode, allows finding strings in digest



HIDD_ADVICE_EDIT_DIALOG 

195 // in author mode, the Syntax check... dialog



Miscellaneous



Click the OK button to accept the settings in this dialog box. This will also close the dialog box.



Click the Cancel button to close this dialog box without changing any of the settings.



Click the Yes button if you are ready to proceed with the indicated operation.



Click the No button if you don't wish to proceed with the indicated operation.



This is a message dialog box. Click on one of the buttons to proceed.



This is the icon for the selected Fixlet site. The icon changes to a globe when more than one site is 
selected.



This is the title bar for the currently active window. It has a caption at the left to identify its contents.



This is a horizontal scrollbar. Click on the arrow buttons or grab the gray box and slide it left and right 
in order to horizontally scroll the contents of the associated window.



This is a vertical scrollbar. Click on the arrow buttons or grab the gray box and slide it up and down in 
order to vertically scroll the contents of the associated window.



Minimize

Click this button to minimize the window. This causes the window to reduce itself to a button. Click on this 
button to reopen the window.



Maximize

Click this button to expand the window to its maximum frame size. The button is a toggle -- click it again 
to return to the multi-window mode.



Restore

Click this button to restore a maximized window to a multiple window view. This button toggles back to the 
maximized view.



Close
Click this button to close the current window. 



Minimize the Program

Click this button to minimize the window. This will cause the program to shut down its open windows and 
reduce itself to a button on the task bar. Click on this taskbar button to reopen the program windows.



Maximize the Program

Click this button to maximize the window. This will cause the program to enlarge its main window to fill the 
entire screen. This is the single-window mode. The button is a toggle -- click it again to return to the multi-
window mode.



Minimize the Window

Click this button to minimize the window. This will cause the window to reduce itself to a button at the 
bottom of the application window. Click on the multi-window button to reopen the program windows.
The multi-window button:



Maximize the Window

Click this button to maximize the window. This will cause the window to fill the application frame. This is 
the single-window mode. The button is a toggle -- click it again to return to the multi-window mode.
The multi-window button:



Close the Window





Canned Dialog boxes



File Open dialog box

The following options allow you to specify which file to open:

Look in:
Select the folder for the file you want to open. 

File name:
Type or select the filename you want to open. 

Files of type:
Select the type of file you want to open. Depending on what command invoked this dialog box, the file types 
include:
*.fxf Fixlet File
*.fxm Fixlet Masthead
*.fxg Fixlet Pool



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:

Save in:
Select the folder where you want to store the file.

File name:
Type a new filename to save a document with a different name. BigFix adds the extension you specify in the 
Save as type box.

Save as type:
Select the type of file you want to save. Depending on what command invoked this dialog box, the file types 
include:
*.fxf Fixlet File
*.fxm Fixlet Masthead
*.fxg Fixlet Pool



Print dialog box

The following options allow you to specify how the document should be printed:

Printer
This is the active printer and printer connection.    Choose the Setup option to change the printer and printer 
connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:

All Prints the entire document.
Selection Prints the currently selected text.
Pages Prints the range of pages you specify in the From and To boxes.

Copies
Specify the number of copies you want to print for the above page range.

Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.

Print Quality
Select the quality of the printing.    Generally, lower quality printing takes less time to produce.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.

Printer
Select the printer you want to use.    Choose the Default Printer; or choose the Specific Printer option and select 
one of the current installed printers shown in the box.    You install printers and configure ports using the 
Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to the type of printer you 
have selected.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.






